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Turn Any Font Into a Sketch Font
Tutorials | June 11Th, 2009

There are some popular sketchy fonts available that are great for grungy and hand-drawn 
designs and illustrations. My problem is, I want to be able to use this sketchy style in any 
font. Turn’s out, it is actually really easy to do in Illustrator. Moreover, you can create a 
Graphic Style and easily apply the style to other editable fonts!

Notes
This tutorial was created with Adobe Illustrator CS4, but you should be able to create the tutorial in other 
Illustrator CS versions.

Final Image
Below is an example of the sketchy text we will be creating.
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Step 1
Create a new document and with the Text tool (T), type out some text with the with the font 
of your choosing. I am using Glypha Black as my font.

Step 2
With the text selected, take off any stroke and fill. We are going to add a stroke a fill 
separate from each other in the Appearance panel in the next couple of steps.

Step 3
With the no fill and no stroke text selected, open the pop-up menu in the Appearance panel 

http://www.linotype.com/494/glypha-family.html


and chose Add New Fill. Keep the default black color of the fill.



Step 4
Select the new fill in the Appearance panel and go Effect > Stylize > Scribble. With the 
Scribble Options dialog open, change the Angle to 45, the Path Overlap to 0 px, the Path 
Overlap Variation to 2 px, the Stroke Width to 1 px, the Curviness to 0, the Curviness 
Variation to 50, the Spacing to 2 px, and the Spacing Variation to 1.5 px.





Step 5
Select the Stroke option in the Appearance panel and give the text a 2 pt stroke.

Step 6
With the Stroke still selected in the Appearance panel, go Effect > Distort & Transform > 
Roughen. In the Roughen dialog, change the Size to .5, select the Relative radial button, 
change the Detail to 30, and select the Smooth radial button for Point. This will give the 
stroke a little distress.



Step 7
Now, we have a custom sketchy font. Moreover, you can easily edit the font! To make this 
technique even more useful, let’s create a Graphic Style so we can quickly apply these 
effects to other fonts and text. First select your font and take a look at the Appearance 



panel. You can see all the effects in your type. Now, simply press the New Graphic Style 
Button in the Graphic Styles panel!

Step 8
Now type out some more text and change the font. With the text selected, press the 
thumbnail of your new sketchy Graphic Style and see all the wonderful sketchy results!





Experiment
You can apply the sketchy graphic style to other objects other than text. I also suggest 
playing around with the Sccrible and Roughen effect settings. Post links to images in the 
comments with your results!
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1.  Fetching Vectors

says:

June 11, 2009 at 12:15 pm 

How cool is this? I never would have imaged that creating a sketch font could be so 
easy.
Reply

2.  Theo
says:

June 11, 2009 at 12:19 pm 

Now that’s an awesome tutorial. Thank you.
Reply
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3.  rawmeyn

says:

June 11, 2009 at 12:47 pm 

great tip! thanks!!!
Reply

4.  ARHK
says:

June 11, 2009 at 1:18 pm 

Like it. Very simple.
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5.  Bernadette
says:

June 11, 2009 at 3:31 pm 

I cannot thank you enough. I’ve been searching for so long on how to do this. And it’s 
so simple even a novice like me could do it. thank you for your great site!  
Reply

http://roman.koenighofer.net/
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-24027
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=24027#respond
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-24032
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=24032#respond
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-24051
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=24051#respond


6.  Jeff Deibel

says:

June 11, 2009 at 5:09 pm 

What’s the cursive font you are using in the example?
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◦  Rype

says:

June 15, 2009 at 3:13 pm 

It is called Susa
Reply

▪  Jeff Deibel

says:

June 17, 2009 at 12:39 pm 

Thanks for filling (or should I say scribbling?) me in on the cool font. Great 
technique article!
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▪  Tony
says:

October 6, 2010 at 6:08 am 

Any free version of the ‘susa’ font ?
Reply

▪  Rype

says:

October 7, 2010 at 7:58 am 

Not that I know of.
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7.  Paula Cevasco
says:

June 11, 2009 at 7:40 pm 

So simple and such a grate result! I love it!..the newsletter came in at the right time, 
Im using it already..thxs
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says:

June 11, 2009 at 8:33 pm 

Basic and helpful guidelines  
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9.  Peter

says:

June 12, 2009 at 12:15 am 

Nice but i already knew this.
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◦  joe l
says:

April 25, 2011 at 9:06 am 

why comment?
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10.  Matt
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Awesome!
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11.  Ann Childs
says:

June 12, 2009 at 12:48 am 

Wow! That is just the best tip ever! I’ve been wondering how to do this for ages and 
can’t believe it’s so easy! Thank you a million scribbly times!!!
Reply

12.  Nqy_Nik
says:

June 12, 2009 at 1:09 am 

WOW, great little tutorial so useful…Thanks.
Reply

13.  Atilano

says:

June 12, 2009 at 1:36 am 

The tutorial is sheer elegance, for this trendy visual approach. Not that I may use it too 
much, but thanks for this eye-treat!
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http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-24134
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=24134#respond
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-24137
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=24137#respond
http://atilanosuarez.no.sapo.pt/
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-24141
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=24141#respond


14.  Jelle

says:

June 12, 2009 at 1:36 am 

Nice to see an experiment using line and fill layers. Great work.
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15.  Morten FC

says:

June 12, 2009 at 2:08 am 

Brilliant! And it doesn’t have that ‘vector feel’. I really looks believable.
Now I just have to find a project to apply this to…
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16.  Maluson
says:
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Thanks for the tuts man!
Reply

17.  Patternhead

http://www.ambrero.nl/
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-24142
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=24142#respond
http://www.mortenfc.dk/wordpress
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-24150
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=24150#respond
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-24159
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=24159#respond
http://www.patternhead.com/


says:

June 12, 2009 at 3:11 am 

Excellent tutorial. Sure I’ll find a use for this.
Thanks for sharing  
Reply

18.  caleb

says:

June 12, 2009 at 5:45 am 

How cool is that? This is great.
Reply

19.  Felipe Caroé

says:

June 12, 2009 at 6:14 am 

Holy Moly! Thats GREAT!
Thanks a lot, buddy!
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June 12, 2009 at 6:20 am 

Where can I find the appearance-button?
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◦  Rype

says:

June 12, 2009 at 7:44 am 

You can get to the Appearance panel by going Window > Appearance.
Reply

21.  Phan Huy Quyen
says:

June 12, 2009 at 6:29 am 

Thanks
Reply

22.  coka
says:

June 12, 2009 at 7:47 am 

very nice and easy tutorial, thanks!!!
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23.  T-Law

says:

June 12, 2009 at 7:53 am 

That’s great thanks.
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24.  CathieT

says:

June 12, 2009 at 7:57 am 

This is great …
I’ve used it already.
http://images-0.redbubble.net/img/clothing/bodycolor:grassgreen/cropped/size:large/
style:mens/view:preview/3242358-1-scribble.jpg
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◦  CathieT

says:

June 12, 2009 at 8:00 am 

Oops. Try here. http://www.redbubble.com/people/cathiet/t-shirts/3242358-1-
scribble
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25.  dentednj
says:

June 12, 2009 at 8:07 am 

Thanks so much. Just played around a bit with it…
Reply

26.  Alin

says:

June 12, 2009 at 8:44 am 

I love this effect…thanks.
Here is my result http://twitpic.com/777vd
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Great TUT, Thanx a mil
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says:

June 12, 2009 at 9:42 am 

That is awesome! Very useful to know how to make swatches of fills
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29.  Adrian

says:

June 12, 2009 at 10:29 am 

Solid! Nice effect easy to replicate. Thanks!
Reply

30.  Cal
says:

June 12, 2009 at 1:49 pm 

Your tutorials are always awesome!
Reply

31.  Niek
says:

June 13, 2009 at 3:03 am 

Thanks allot, usefull and ez to understand as usual. Thnx m8
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32.  James De Angelis

says:

June 14, 2009 at 7:37 pm 

Super useful tip!
Hope you keep up with Vectips dude, it really is one of the best illustration resources 
on the web!
Reply

33.  Branden

says:

June 15, 2009 at 6:17 am 

Nice work as usual Rype. I definitely need to remember this one for those sketchy font 
moods. More unique and control this way.
Reply

34.  Lucy
says:

June 15, 2009 at 11:36 pm 

Thank you a lot! I can’t believe – it’s so simple!  )
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35.  hrMcWhinney
says:

June 16, 2009 at 9:09 am 

-wow…love this, thank you!
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36.  preeti
says:

June 18, 2009 at 3:22 am 

Thanks for sharing .That was quite useful and step by step tutorial.
Hope to have such more
Reply

37.  Punky

says:

June 23, 2009 at 5:10 am 

this is awesome !! fonts looks so much better .. thank you very much !
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says:

June 23, 2009 at 9:29 am 

Great Tutorial. Thanks a lot..
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39.  Graphixtyle
says:

June 25, 2009 at 3:15 pm 

Very Very useful and cool
Reply

40.  Samoo

says:

June 26, 2009 at 3:33 am 

A real handy effect! Thanks!
Reply

41.  Nazia
says:

June 29, 2009 at 5:08 am 

Thanks for your nice tutorial.
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42.  Ben

says:

June 29, 2009 at 7:09 pm 

this is awesome! thanks!
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43.  2pxborder

says:

June 30, 2009 at 5:22 am 

WOW, that is so cool,thanks alot
Reply

44.  Alen

says:

July 1, 2009 at 8:05 am 

Nice tutorial.
Reply

http://www.benjaminpedroza.com/
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-26320
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=26320#respond
http://2pxborder.co.nz/
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-26358
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=26358#respond
http://www.mypcspot.com/
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-26480
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=26480#respond


45.  ai
says:

July 3, 2009 at 6:56 pm 

your effect looks excellent in Japanese too.
thank you.
Reply

46.  gusat
says:

July 4, 2009 at 12:14 pm 

Thanks for the tutorial  
Reply

47.  Bob

says:

July 6, 2009 at 11:02 am 

Awesome! Thank you
Reply

48.  Pu
says:
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July 7, 2009 at 1:06 am 

Great! thanks for your support!
Reply

49.  Patelligence

says:

July 8, 2009 at 8:41 am 

What a great tip!! I can’t thank you enough for this! Just what I needed (I;m creating a 
T-shirt design and this is just perfect for what I had in mind).
Keep posting!!!
Reply

50.  Baptiste

says:

July 12, 2009 at 7:37 am 

Thx man  
Reply

51.  reezluv

says:

August 2, 2009 at 3:38 am 
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aha..that’s easy..thanks for the guide..it’s really help me a lot.:P
Reply

52.  Ross

says:

August 8, 2009 at 10:53 pm 

Thanks for this! I have used these tips to crate the title for my blog  
Reply

53.  Vishal Gupta
says:

August 12, 2009 at 12:57 am 

That is called a heavenly stuff!
Thank you a ton!
Reply

54.  Design Wannabe

says:

August 14, 2009 at 8:44 am 

Ok now, that was way easier than I thought that text effect would be. remarkable.
Reply
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55.  Beder
says:

August 19, 2009 at 1:47 pm 

Adorei!!!
Vlw…
Reply

56.  Samuel

says:

August 19, 2009 at 8:51 pm 

Another nice tutorial, man I’m learning a lot from you!, thanks I’m just starting using 
Illustrator I have more experience with Photoshop.
Thank!.
Reply

57.  globalspex

says:

August 22, 2009 at 8:34 am 

Wow! This is a great tutorial and money saver too.
Reply
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58.  jewelry

says:

September 24, 2009 at 12:29 am 

Awesome tutorial!!!!
Thanks!
Reply

59.  Shashank

says:

September 24, 2009 at 4:23 am 

Superb! Very simple to apply and an Exceptional results!
Reply

60.  Max
says:

September 28, 2009 at 5:40 pm 

Awesome, always thought this was a typeface!
Reply

61.  Kyle
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says:

September 29, 2009 at 1:09 pm 

Very nice! Thanks!
Reply

62.  chaim

says:

September 30, 2009 at 11:27 am 

I put your tutorial on one screen and illustrator on the other screen and followed step-
by-step and got the results, wow this is amazing, especially that we can reuse this 
effect with out all the work. well done.
Reply

63.  Bene

says:

October 1, 2009 at 6:21 pm 

Dude, your tutorials are so great. This one come really handy with a new project I am 
working on, tyvm.
Reply

64.  Tutsnips
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says:

October 3, 2009 at 2:12 am 

Nice tutorial. This will be very handy for my upcoming site logo. Thanks Alot!
Reply

65.  Aias

says:

October 8, 2009 at 11:38 am 

sweeeeeet!
Reply

66.  Sampson Orson Jackson
says:

October 19, 2009 at 1:26 am 

Hi Rype,
I am using Illustrator CS3 and i can not find Effect > Stylize > Scribble. Can you help 
me out. I have been looking for this technique for a while now.
Reply

◦  Rype

says:

October 19, 2009 at 8:20 am 
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Not sure what could be the problem, the Scribble Effect Should be under The 
Menu Bar > Effect > Stylize > Scribble for CS3 just like CS4. Does that help?
Reply

▪  Giff P.
says:

January 10, 2010 at 8:18 am 

I have the same problem like Samson, My illustrator don’t have this effect 
too?
Reply

◦  Jab
says:

July 25, 2011 at 9:48 pm 

There are two stylize menus, one under illistrator and one on photoshop, make 
sure you’re using the top one.
Reply

▪  Kalib
says:

March 9, 2012 at 5:36 am 

haha wow, I feel stupid, thanks for the help
Reply
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67.  JW
says:

October 26, 2009 at 1:48 am 

Creat tutorial. Really easy but so useful…
Reply

68.  Steve
says:

November 2, 2009 at 12:50 pm 

Is anyone else struggling to roughen the stroke from the Appearance panel?
Reply

◦  Rype

says:

November 2, 2009 at 1:23 pm 

Is it just not working? What version of Illustrator are you on?
Reply

69.  graphicpin

says:
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November 4, 2009 at 3:06 am 

Awesome, cheers
Reply

70.  Jules Manson
says:

November 6, 2009 at 3:30 pm 

Thank you, this tutorial helped me out with my homework for a digital arts class I am 
taking at my local community college.
Reply

71.  Bobert
says:

November 15, 2009 at 2:53 pm 

Very useful! Thank you.
Reply

72.  Stom365
says:

November 23, 2009 at 1:43 pm 

Thanks a lot, it’s wonderful tutorial !!!
Reply

http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-44635
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=44635#respond
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-44987
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=44987#respond
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-45777
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=45777#respond
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-46212
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=46212#respond


73.  Nano

says:

November 24, 2009 at 12:39 am 

Hi,
Your teaching style is too good and information about photoshop is very useful for 
visitor
Reply

74.  Justin
says:

November 24, 2009 at 2:40 pm 

Just be sure to check the license on the typeface you’re going to use for this. You 
don’t want to end up doing this for a client, only to find yourself being sued by the type 
designer or foundry. Look specifically for lines that mention modifications to the 
original design. Some do, but some don’t. When in doubt, ask before you do anything 
other than just playing.
Reply

◦  Rype

says:

November 24, 2009 at 3:06 pm 

Really good point!
Reply
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75.  jakem
says:

November 30, 2009 at 8:19 am 

what font is the second one try it on a different font???
Reply

◦  Rype

says:

November 30, 2009 at 9:57 am 

It is a font called Susa.
Reply

▪  jakem
says:

November 30, 2009 at 2:08 pm 

cheers for that, but do you know where i can download it for free?
Reply

76.  Rihards
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says:

January 12, 2010 at 1:28 am 

Wow, it’s actually a lot easier than I thought. Thanks for the great tutorial  
Reply

77.  Ly Antie

says:

January 12, 2010 at 8:21 pm 

Awesome!!! Just like my friend design on inijie.com
Thanks for sharing, I will practice it now.
Reply

78.  olis
says:

January 13, 2010 at 2:25 am 

Great article, thx 
Also some nice free fonts http://www.fonts2u.com
Reply

79.  Leo

says:

January 18, 2010 at 1:29 pm 
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that`s what i`m talking about!
Reply

80.  lunar faith
says:

March 15, 2010 at 2:34 am 

wao .. look (@-@) I love this !!
Reply

81.  hanif IM

says:

April 15, 2010 at 2:20 am 

wau, interesting and easy step for me. I had combine any color for my font. thanks for 
your tips.
Reply

82.  Web Design

says:

April 22, 2010 at 3:24 pm 

Nice tutorial bro great stuff
Reply
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83.  nosiaht
says:

May 10, 2010 at 1:06 pm 

what if i wanted to make similar effects on vectors other than text?
i tried this method on vectors but got short on the part where you go to apply the 
scribble effect in stylize since the option doesnt exist? is it only for text?
thanks
Reply

◦  Rype

says:

May 11, 2010 at 7:55 am 

You should have no problem applying to Graphic Style and techniques to other 
vector objects. When you are applying the Scribble effect, is it grayed out?
Reply

84.  Martijn

says:

May 15, 2010 at 9:15 am 

Wow, this was JUST what I needed! Thanx!
Reply
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85.  vasntvel

says:

May 28, 2010 at 1:25 am 

what ya mind super
okaya
Reply

86.  fere

says:

June 4, 2010 at 11:52 am 

super easy and looks really cool!! thank you for this…!!
Reply

87.  Barbara

says:

June 14, 2010 at 4:44 am 

So simple, so useful. One tutorial as I like it.
Reply
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88.  paola lozano

says:

June 15, 2010 at 9:53 am 

Love this!
Reply

89.  Ami

says:

June 16, 2010 at 3:28 am 

WOW! And here’s me thinking I would never EVER understand illustrator and first time 
I get my perfect scribble text. Not just that, but I was even able to succesfully play 
around with the colours and scribble effect attributes to get the perfect scrawl. THANK 
YOU SO MUCH. xxx
Reply

90.  ancheer
says:

June 24, 2010 at 9:30 pm 

cool! the style is nice.
Reply
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91.  The Guy

says:

June 25, 2010 at 8:26 pm 

Thanks for a great tutorial!
Reply

92.  Tomas
says:

September 15, 2010 at 1:38 pm 

Awesome, thanks!
Reply

93.  MalloryS
says:

September 17, 2010 at 6:52 am 

You have some really great tutorials! Thanks for sharing them.
Reply

94.  Raph
says:
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September 23, 2010 at 12:13 pm 

Thx a lot! You make my day! ^_^
Reply

95.  joe

says:

October 13, 2010 at 4:55 pm 

Great Champ!!!
Reply

96.  Cecelia Wing

says:

October 21, 2010 at 9:42 am 

very informative
Reply

97.  Whitney

says:

November 2, 2010 at 7:58 am 

Awesome tip — you saved my morning!
Reply
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98.  qwildz
says:

November 18, 2010 at 10:08 am 

can anybody help me?? scribble option does not exist in my illustrator… there just 
glowing edges style effect. i’ve use illustrator cs5.. how to make that option appears? 
i’ve try to clear uninstall and reinstall.. but still not work..
thx..
Reply

◦  Rype

says:

November 18, 2010 at 10:59 am 

Is it just grayed out or not under Effects > Stylize > Scribble at all?
Reply

◦  Charles
says:

January 27, 2011 at 3:01 pm 

I did the same thing on first glance. There are two Scribble options. You are 
looking at the one under Photoshop effects. Look in the section above that under 
Illustrator effects.
Reply
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99.  Mansi
says:

November 26, 2010 at 1:07 pm 

Super duper tutorial. Awesome. Thanks a ton.
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100.  Mike305

says:

November 28, 2010 at 7:52 pm 

Great tutorial – I have used it on both of my sites!
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101.  avn rocky

says:

December 15, 2010 at 10:51 pm 

Nice Tut, Thanks  
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102.  anne
says:
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December 23, 2010 at 2:05 am 

super!! love this so much..thanks a lot  
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103.  Piero
says:

January 13, 2011 at 9:27 am 

I love this tutorial!! but my results it’s not as yours why?
i have illustrator CS5, this is my result,
http://img560.imageshack.us/i/schermata20110113a17242.png/
but i want yours  how i can? what’s i wrong?
Reply

104.  Charles
says:

January 27, 2011 at 4:15 pm 

I found this tutorial incredibly helpful in doing exactly what I was looking to do, create a 
sketchy look to a font. However, I want to take it a step further from Illustrator. I want 
to create a font from the effect. I have outlined the font in Illustrator with the effect on 
it so each letter is individual (with scribble effect still on it). I have then tried to copy 
and paste an individual letter into Fontographer without success (it comes through as a 
solid black version of the font). I have also tried and copy and paste it just into another 
Illustrator file and it goes all white, losing the effect as well. Is there any way I can 
take this style as individual letters from Illustrator into Fontographer to create a version 
of our house font, retaining the scribble effect which is so perfect in Illustrator from 
using this technique?
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105.  Pushpa
says:

February 3, 2011 at 5:32 am 

Thx u soooo much for wonderful tips….
Reply

106.  Dudi
says:

April 3, 2011 at 11:31 am 

This is really awesome!!! It helped me ALOT…
You saved me all time of searching for a scribbled font type on line… Thanx sooooo 
much…
I’m in love with Illustrator, it a really Great program!
Reply

107.  Diana
says:

April 7, 2011 at 1:50 am 

amazing!!!!! can’t believe I had been suffering trying to get this effect for so long LOL 
your tut has made my day, thank you!  
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108.  Renae

says:

May 10, 2011 at 7:58 pm 

What a great tutorial! Thanks so much! I see a whole new set of web buttons for my 
blog on the horizon.
Reply

109.  Vanessa
says:

May 22, 2011 at 10:56 pm 

When I went to “Effect > Stylize,” there was no “Scribble” option. What did I do wrong?
Reply

◦  Rype

says:

May 26, 2011 at 12:41 pm 

What version of Illustrator are you running?
Reply

110.  Max McQueen
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says:

July 8, 2011 at 9:27 pm 

Love It!
Reply

111.  Alice
says:

August 18, 2011 at 12:01 pm 

Thank for this tutorial and for sharing it!
Reply

112.  ritsuko
says:

August 27, 2011 at 12:00 pm 

thank you for nice tips!
Reply

113.  dnlmello
says:

October 25, 2011 at 6:43 am 

simple, fast = awesome. Tks a lot!
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114.  Raphael

says:

November 6, 2011 at 11:19 pm 

I love it again  
Reply

115.  nastya
says:

December 6, 2011 at 2:46 am 

thank you ! This helped me in my work
Reply

116.  Manuel
says:

December 22, 2011 at 5:33 am 

Thanks for the tutorial. awesome
Reply

117.  Courtenay
says:
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March 18, 2012 at 6:22 pm 

Great tut thank you!
i’m having a few problems with it though.. i have to make my font 200 or so to get the 
sketchy-ness to look any good and even then it doesn’t look as smooth as yours?? 
I’ve played around with the settings in the scribble options dialogue box but it doesn’t 
seem to make it any better. my settings are in mm and i wondered if that was the 
problem? rather than px.. Any tips would be fantastic. Cheers
Reply

118.  Hieu Le Trung

says:

March 20, 2012 at 10:16 am 

Thank a lot! I used this tutorial to design the logo of my new website.
Reply

119.  Tom!
says:

March 24, 2012 at 6:12 pm 

Thanks, really good tutorial! Learnt a lot!
Reply

Trackbacks/Pingbacks
1. Turn Any Font Into a Sketch Font in Illustrator | Vectips « Netcrema - 

creme de la social news via digg + delicious + stumpleupon + reddit

says:

http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-384045
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=384045#respond
http://webtrunghieu.info/
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-385350
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=385350#respond
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-388596
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=388596#respond
http://www.netcrema.com/?p=3667
http://www.netcrema.com/?p=3667


June 12, 2009 at 6:10 am 

[...] Turn Any Font Into a Sketch Font in Illustrator | Vectipsvectips.com [...]
Reply 

2. Turn Any Font Into a Sketch Font in Illustrator | Design Newz

says:

June 14, 2009 at 12:32 pm 

[...] Turn Any Font Into a Sketch Font in Illustrator [...]
Reply 

3. The Best Web Design Links Of The Weekend | D-Lists

says:

June 14, 2009 at 1:49 pm 

[...] Turn Any Font Into a Sketch Font via Vectips [...]
Reply 

4. Best Tutorials, Websites and Resources of the Week | Webdesigner blog

says:

June 15, 2009 at 12:15 pm 

[...] Turn Any Font Into a Sketch Font [...]
Reply 

5. 10 Easy to Follow Adobe Illustrator Vector Tutorials - Graphic Design 
Free Resources

says:

July 2, 2009 at 10:35 pm 

[...] Turn Any Font Into a Sketch Font – from [...]
Reply 

6. MyInkTrail: Best of the Design Community June 2009 | My Ink Blog

says:

July 5, 2009 at 12:54 pm 

[...] Turn Any Font Into a Sketch Font [...]
Reply 

7. Creative Bookmarks: Best of June 2009 - Tutorial9

http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-24194
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=24194#respond
http://design-newz.com/2009/06/14/turn-any-font-into-a-sketch-font-in-illustrator/
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-24510
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=24510#respond
http://www.d-lists.co.uk/2009/06/14/the-best-web-design-links-of-the-weekend/
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-24518
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=24518#respond
http://bartekwinnicki.com/blog/picks/web-picks-of-the-week-3/
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-24617
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=24617#respond
http://www.designfreebies.org/vector-tutorials/some-of-the-best-and-easy-to-follow-adobe-illustrator-vector-tutorials/
http://www.designfreebies.org/vector-tutorials/some-of-the-best-and-easy-to-follow-adobe-illustrator-vector-tutorials/
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-26776
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=26776#respond
http://www.myinkblog.com/2009/07/05/myinktrail-best-of-the-design-community-june-2009/
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-27028
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=27028#respond
http://www.tutorial9.net/resources/creative-bookmarks-best-of-june-2009/


says:

July 5, 2009 at 11:33 pm 

[...] Turn Any Font Into a Sketch Font [...]
Reply 

8. Best of The Web – June 2009 | Web Design Tutorials | Creating a 
Website | Learn Adobe Flash, Photoshop and Dreamweaver

says:

July 8, 2009 at 5:28 am 

[...] This great tutorial will teach you how to turn any font into sketch. This can work 
well for titles, and a hand drawn design. View Tutorial [...]
Reply 

9. Best of The Web – June 2009

says:

July 10, 2009 at 1:56 am 

[...] This great tutorial will teach you how to turn any font into sketch. This can work 
well for titles, and a hand drawn design. View Tutorial [...]
Reply 

10. kopfkribbeln webdesign-blog » Beliebigen Font in einen Sketch 
umwandeln

says:

July 31, 2009 at 1:58 am 

[...] Sketches sind modern und verleihen jedem Layout eine individuelle Note. Dies 
bietet sich besonders bei der Schrift an. Das man mit ein paar Einstellungen im 
Illustrator aus jedem Font ein Sketch-Font machen kann, beweist dieses Tutorial. [...]
Reply 

11. 27 New and Fresh Illustrator Tutorials | Vandelay Design Blog

says:

September 17, 2009 at 5:18 am 

[...] Turn Any Font into a Sketch Font [...]
Reply 

12. Back-to-School With 40 Excellent Adobe Illustrator Tutorials « 
Smashing Magazine

http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-27082
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=27082#respond
http://www.webdesigndev.com/roundups/best-of-the-web-june-2009
http://www.webdesigndev.com/roundups/best-of-the-web-june-2009
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-27378
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=27378#respond
http://www.webdesign.redviewpoint.com/tutorial/best-of-the-web-%e2%80%93-june-2009/
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-27679
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=27679#respond
http://www.kopfkribbeln.eu/blog/?p=741
http://www.kopfkribbeln.eu/blog/?p=741
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-29572
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=29572#respond
http://vandelaydesign.com/blog/design/new-illustrator-tutorials/
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-38128
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=38128#respond
http://www.smashingmagazine.com/2009/09/23/back-to-school-with-40-excellent-adobe-illustrator-tutorials/
http://www.smashingmagazine.com/2009/09/23/back-to-school-with-40-excellent-adobe-illustrator-tutorials/


says:

September 23, 2009 at 4:35 am 

[...] Turn Any Font Into a Sketch Font [...]
Reply 

13. 10 Vector Tutorials for Design (duh) « iDesign Crap

says:

March 23, 2010 at 9:50 pm 

[...] http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/ – The sketchy look, 
without a font. Turning any font into a sketchy [...]
Reply 

14. Design Groupies » Turn Any Typeface into a Sketch Font: Design 
resource directory & blog for graphic designers, web designers, 
photographers & other creatives

says:

June 15, 2010 at 3:02 pm 

[...] how to make your own sketch font by visiting the Vectips web site. Posted by: 
Head Groupie Categories: Illustrator [...]
Reply 

15. The 50 Best Adobe Illustrator Tutorials from 2009 | Vandelay Design 
Blog

says:

September 13, 2010 at 4:55 am 

[...] Turn any Font into a Sketch Font [...]
Reply 

Leave a Reply
Name (required)
Mail (will not be published) (required)
Website

http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-39117
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=39117#respond
http://idesigncrap.wordpress.com/2010/03/24/10-vector-tutorials-for-design-duh/
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-64040
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=64040#respond
http://designgroupies.com/illustrator-tutorials/turn-any-typeface-into-a-sketch-font/
http://designgroupies.com/illustrator-tutorials/turn-any-typeface-into-a-sketch-font/
http://designgroupies.com/illustrator-tutorials/turn-any-typeface-into-a-sketch-font/
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-79491
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=79491#respond
http://vandelaydesign.com/blog/design/illustrator-tutorials-2009/
http://vandelaydesign.com/blog/design/illustrator-tutorials-2009/
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/comment-page-1/#comment-94392
http://vectips.com/tutorials/turn-any-font-into-a-sketch-font/?replytocom=94392#respond


•

Subscribe to a feed
• RSS Feed

• Email
• Twitter Links

What is RSS? Learn More

Community Images via Flickr

Join the Vectips Flickr group!

About Vectips
Vectips is a site dedicated to Illustrator tips, tricks, and tutorials. It was created by Rype 
(Ryan Putnam) of Rype Arts an exclusive vector art contributor to iStockphoto.
Learn More

Write for Vectips
Write a tutorial or article for Vectips and get exposure while giving back to the community.
Learn More

Work With Vectips
Like the design and illustrations on Vectips? Hire Rype Arts for your next project!
Learn More

Connect with Vectips
Twitter
FriendFeed
Flickr
Facebook
Vi.sualize.us

http://vectormill.com/
http://feeds.feedburner.com/Vectips
http://www.feedburner.com/fb/a/emailverifySubmit?feedId=1705245&loc=en_US
http://twitter.com/statuses/user_timeline/14891394.rss
http://feeds2.feedburner.com/Vectips
http://news.bbc.co.uk/2/hi/help/3223484.stm
http://www.flickr.com/photos/17221206@N00/6897762180/in/pool-926271@N25
http://www.flickr.com/photos/visualinguist/6897453966/in/pool-926271@N25
http://www.flickr.com/photos/jonnywan/7043420449/in/pool-926271@N25
http://www.flickr.com/photos/glennztees/7042473519/in/pool-926271@N25
http://www.flickr.com/photos/maiz_m/7042398233/in/pool-926271@N25
http://www.flickr.com/photos/maiz_m/6837603920/in/pool-926271@N25
http://www.flickr.com/photos/maiz_m/6517188633/in/pool-926271@N25
http://www.flickr.com/photos/orange_zutto/5131397086/in/pool-926271@N25
http://www.flickr.com/photos/orange_zutto/3316412989/in/pool-926271@N25
http://www.flickr.com/groups/vectips
http://vectips.com/about-vectips
http://vectips.com/about-vectips
http://vectips.com/about-vectips
http://twitter.com/vectips
http://friendfeed.com/vectips
http://flickr.com/photos/vectips
http://www.facebook.com/pages/Vectips/57737957872
http://vi.sualize.us/vectips/


Copyright © Rype Arts 2011

http://rypearts.com/
http://rypearts.com/
http://rypearts.com/

